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Chapter 1 Introduction

Congratulations on purchasing this digital camera. Your digital
camera is compact and ergonomic and capable of taking pictures
at resolutions as high as 12 megapixels (4032 x 3024 pixels, extrap-
olated resolution). The digital camera can also record movies and
has an 8x digital zoom.

Features

Compact, stylish design

Digital zoom 8x

3.1 megapixel high-resolution CMOS (2074 x 1540
pixels)

Maximum resolution 12 megapixels (4032 x 3024
pixels, extrapolated resolution)

Video capture resolution of 320 x 240, 30 fps;
640x480, 24fps

Super Large 2.5 Inch LCD

Voice memo

Supports SD card media

Built-in 32MB Memory
Self-timer mode

Continuous shooting mode
Full-speed USB2.0 Port

TV output

Built-in microphone and speaker
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Package contents

Make sure that your package contains the following components. If
anything is missing or damaged, contact your dealer immediately.
Retain the packaging in case you need to ship the digital camerain
the future.

+ Digital camera

« Hand strap

* Quick start guide

« User manual (on CD)

* AAA batteries x 2

+ USBcable

+ CD-ROM including drivers and software
« Audio/Video Cable

+ Charger
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Camera overview

Familiarize yourself with the controls of the digital camera with the
illustrations below.

Front view
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Top View
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Chapter 2 Getting Started

Attaching the hand strap.

1. Thread the short loop of the hand strap
through the hand strap eyelet on the
camera

2. Thread the long loop of the hand strap
through the short loop.

3. Pull the long loop tight.

Inserting the batteries

1. Slide the battery/memory card cover
on the underside of the camera in
the direction of the arrow.

2. Open the cover.

3. Insert the batteries into the
compartment observing correct
polarity.

4. Close the cover and snap itinto place
in the direction of the arrow.
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Turning the camera on and off
Press the Power button on top of the camera to turn camera on.

Power button

—— 3

N
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Press the Power button again to turn the camera off.

Inserting an SD card

1. According to the direction indicated
by the arrow, position the label on the
SD card toward the front of the cam-
era. Then push the card into the slot
until it stops.

Note: SD cards can only be inserted facing one direction. If the card
does not enter the slot easily, do not force it. Make sure the card
is facing the correction direction.
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Using the LCD display

The LCD functions as a view finder, allowing you to frame pictures
and video in Picture or Video mode, and view pictures and videos in
Playback mode. The LCD allows you to adjust the camera’s settings
through the on-screen menus.

The LCD displays icons to indicate camera settings.

Changing LCD settings

Mode
button

R

NO=:

The LCD starts in normal setting. In Picture or Video mode:

+ Press the OK button once to turn on the red fram-
ing grid.

+ Press the OK button again to turn off the framing
grid and icons.

+ Press the OK button again to turn off the LCD.

+ Press the OK button again turn the LCD on and dis-
play the icons.

In Playback mode:

+ Press the OK button to turn off the icons.
+ Press the OK button again to turn off the LCD.

+ Press the OK button again to turn the LCD on and
display the icons.
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Understanding the LCD icons
Each mode has different icons to indicate settings.
Picture mode

Flash icon Resolution Image quality
] [ | Remaining number

. . B [ y of pictures you can
Picture modeicon gy €/ 30¢  0.sil B OU0E— rake on the current
Scene setting icon— memory

Indicates that

, — thereis insufficient
' light to prevent
blurring.

Zoom—

Battery status icon Current time

EV adjust setting Focus bracket

Playback mode
DPOF icon
I Current file
File type ﬁ o :’,j'-j‘ ul-—lli " +a 1.~ —number/total files
TR /1.4 — Resolution

W5 4

K/

Battery status icon

Protection icon
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Video mode

Video resolution

Video mode icon_g_‘ ICLES GO0 — Video length
N .m— Recording icon
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Chapter 3 Taking still images or videos

Selecting the camera mode

The digital camera has two capture modes: Picture and Video. Use
Picture mode to capture still images and audio. Use Video mode to
capture video and audio.

Use the third mode, Playback mode, to view pictures and videos,
and listen to audio.

Use the Mode switch to change modes.

Mode
switch

i

+ Slide the switch to the upper position to select Photo mode.
+ Slide the switch to the middle position to select Play mode.
+ Slide the switch to the lower position to select Video mode.

Taking pictures

1. Turnthe cameraon.
Make sure the camera is O ¥ oow K G0
in Picture mode.

2. Frame the picture using
the LCD.

3. Press the Shutter
button.

Adjusting the camera settings using the camera buttons
You can use adjust the camera settings to take better pictures.
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Using the digital zoom

The camera has an 8x digital zoom, allowing you to take enlarge
the subject without moving closer.

1

2.
3.

Turn the camera on. Make sure the camera is in Picture or
Video mode.

Frame the picture using the LCD.
Press the Zoom in button to
increase the zoom and take a
close up picture of the subject
with more detail. Press the
Zoom out button to decrease
the zoom and take a wider pic-
ture with less detail.

Press the Shutter button to
take the picture.

Using the flash

The flash has three settings for different lighting conditions.
Move the 5-way button left repeatedly to cycle through the dif-
ferent flash settings.

Icon Description

ﬁA Flash is fired automatically if required.

5 Flash is enabled.

@ Flash is disabled.
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Using the self-timer

The self-timer allows you to take hands-free pictures and videos
such as self portraits or group photos.

1. Turn the camera on. Make sure the camera is in Picture
mode.

2. Setthe camera on a stable surface such as a tripod or table
and frame the picture.

3. Frame the picture, making any zoom or flash settings nec-
essary

4. The self-timer has two delay set-
tings. o veh Ty 0000
Press the Right arrow once turn
on the self-timer with a two sec-
ond delay. The icon appears.
Press the Right arrow again to
set the delay to 10 seconds. The
icon appears.

5. Press the Shutter button. The
counter begins counting down
on the LCD. The LED on the front of the camera flashes
once a second to count down.

Note: To cancel the self timer, press the Right button until no icon is
displayed.

Taking sequences

You can take sequences of pictures very quickly one after the
other using the sequence setting. You can use this to make an
action series.

1. Turn the camera on. Make sure the camera is in Picture
mode.

2. Press the Right arrow three
times to turn on the Sequence | (. ] VoA Wy (0%
setting. The icon appears.

3. Frame the picture using the
LCD.

4. Press the Shutter button.

the camera buttons
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Changing the focus setting

o You can change the focus setting of the digital camera for
9 different conditions. Change the setting using the Focus
a switch.
5
Q
s
4
= ° Adjusts the focus setting for

= subjects close to the lens.

Adjusts the focus setting for
A subjects distant from the lens

Recording videos

1. Turnthe camera on. Make sure ,
the camerais in Video mode. 8 @7 CO0KE

2. Frame the picture using the
LCD.

3. Press the Shutter button. The
video begins to record.

4. Press the Shutter button when
you have finished to stop
recording.
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Adjusting the camera settings using the menus
You can adjust settings using the on-screen menu. This enables you
to configure the camera settings and capture pictures with
optimum quality.

Note: The LCD must be switched on to access the on-screen menu.

Using the scene settings

Use this menu item to specify a setting according to the light
environment in which you are taking pictures. To set the scene, do
the following:

1. Turn on the camera and switch to picture mode.

2. Press Menu. S —

3. Move the 5-way button left or rightto e (s
navigate to the Capture menu (Video Resolntlos .
menu in Video mode). Datestamp  »

4. Move the 5-way button up or down to White Ldlanes =y
highlight the Scene submenu.

5. Move the 5-way button right to open
the Scene menu

6. Move the 5-way button up or down to
select from the scene options:

— Auto
— Portrait
— Scenery
— Night scene
— Motion
— Couple shot
— Sepia
- B/W
— Pink
— Green
— Blue
7. Press OK when finished.

Note: In video mode, only Auto, Sepia and B/W scene options are
available.
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Setting the resolution
Use this menu item to select the resolution of the image as follows:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button leftor right to  [iSSsss|

¢ Scene

navigate to the Capture menu. =

4. Move the 5-way buttonup ordownto  [ERR
highlight the Resolution submenu.  White balance

5. Move the 5-way button right to open
the Resolution submenu

6. Move the 5-way button up or down to
select from the scene options:

- 12.0M
- 10.0M
- 5.0M
- 3.1M
- 1.3M
- VGA
7. Press OK when finished.

>
&
<
(%]
=
=
Q
~*
=
m
n
Q
3
(]
-
1]
[
m
-+
=
=}
Q
L]
<
2,
=
Q
-+
=
m
3
(]
=}
<
L]

Setting the date stamp

The date stamp menu enables you to imprint the time and the
date on the image. To set the date stamp, do the following:

1. Turnon the camera and switch to picture mode.

2. Press Menu.

3. Move the 5-way button leftorrightto et
navigate to the Capture menu. & Resolution

4. Move the 5-way buttonup ordownto RS
highlight the Date stamp submenu. i

5. Move the 5-way button right to open
the Date stamp menu.




6.

7.

Chapter 3 Taking still images or videos

Move the 5-way button up or down to
select from the date stamp options:

— Date and time

— No stamp

— Only date

— Only time

Press OK when finished.

Setting the white balance

The white balance enables you to change the preset white
balance setting to suit the lighting conditions in which the
picture is taken.

Turn on the camera and switch to picture mode.

1.
2.
3.

Press Menu.

Move the 5-way button left or right to
navigate to the Capture menu.

Move the 5-way button up or down to
highlight the White balance
submenu.

Move the 5-way button right to open
the White balance submenu.

Move the 5-way button up or down to
select from the date stamp options:

— Auto

— Daylight

— Cloudy

— Tungsten

— Fluorescent

Press OK when finished.

« Date and time

< - |

¢ Scene
¢ Resolution

o Date stamp

(o |

—

o

() Daylight

o Cloudy
Tungsten
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Exposure Settings

By using the Exposure Adjusting menu, you can set the quantity
of light entering into the camera when you take picture. The EV
compensation is expressed as a single number that is used by
the digital camera to calculate the correct combination of aper-
ture and shutter speed for producing optimum quality pictures.
Setting a higher EV compensation value will over-expose a shot
while setting a lower value will under-expose a shot. Exposure
can be adjusted from —2.0 to +2.0. The value is shown on the LCD
display. To change the EV compensation value, do the following:

1. Turnon the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button leftorrightto [l

¢ Resolution

navigate to the Capture menu. o Date stamp
4. Move the 5-way buttonup ordownto B

(e |

White balance

highlight the EV adjust submenu.

5. Move the 5-way button right to open
the EV adjust submenu.

6. Move the 5-way button up or down to
adjust the EV value between -2.0
through +2.0. Select Normal for the
default value.

7. Press OK when finished.

>
&
<
(%]
=
=
Q
-
=
m
n
Q
3
(]
-
1]
[
m
-+
=
=}
Q
L]
<
2,
=
«Q
-+
=
m
3
(]
=}
<
L]




Chapter 3 Taking still images or videos

Setting the encircled exposure
Use the following procedure to set the encircled exposure:

1. Turn on the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button leftorright to [l

¢ Date stamp

navigate to the Capture menu. o White balance

4. Move the 5-way button up or down to
highlight the Encircled exposure
submenu.

5. Move the 5-way button right to open the
Encircled exposure submenu.

6. Move the 5-way button up or down to
select one of the following values:

- 0.3EV
- 0.5EV
— 1.0EV
7. Press OK when finished.
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Setting the quality
Do the following to specify the image or video quality:

1. Turn on the camera and switch to picture or video mode.
2. Press Menu.
3. Move the 5-way button leftorright to [ |

¢ White balance »

navigate to the Capture menu (Video RS @t >
menu in Vldeo mode)'  Encircled exposure »

4. Move the 5-way buttonup ordownto [
highlight the Image quality
submenu in the picture mode or Video Quality submenu
in the video mode.

5. Move the 5-way button up or down to
select from the quality options:

+ Picture mode
— Basic 1:16
— Better 1:12
— Best 1.8
+ Video mode
— CIF 20fps
— CIF 30fps
— VGA 15fps
— VGA 24fps
6. Press OK when finished.
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Chapter 3 Taking still images or videos

Customizing the camera

You can customize the camera according to your preferences.
Refer to the following sections for more information.

Enabling sound effect
Do the following to enable the sound effect:

1. Turnon the camera and switch to picture mode.
2. Press Menu.
3. Move the 5-way button leftorrightto Sl

. 2
navigate to the Setup menu. ~ Welcome
UsB

4. Move the 5-way button up or down to o Date and time
highlight the Sound effect submenu.

5. Move the 5-way button right to open
the Sound effect submenu.

6. Move the 5-way button up or down to
select On to enable the sound effect
or Off to disable the sound effect.

7. Press OK when finished.
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Setting the welcome picture

Use the following procedure to specify the welcome picture shown
when the camera is turned on.

1. Turn on the camera and switch to picture mode.
2. Press Menu.

3. Move the 5-way button left orrightto  BEEE 48
navigate to the Setup menu.

USB >

4. Move the 5-way button up or down to . Dacanatme  »
highlight the Welcome submenu.
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5. Move the 5-way button right to
open the Welcome submenu

6. Move the 5-way button up or down to
select one of the following options:

— Auto
- Off
— Custom pic
7. Press OK when finished.
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Chapter 3 Taking still images or videos

Setting the USB options

Use this option to specify whether the camera is used for storage or
as a web camera when connected to the PC. Refer to “Changing the
USB setting” on page 42 for more details.

Setting the date and time
Use this option to set the date and time as follows:

1
2.
3.

8.

Turn on the camera and switch to picture mode.
Press Menu.
Move the 5-way button leftor rightto [

¢ Sound effect

navigate to the Setup menu. € Welcome

Move the 5-way button up ordownto [

highlight the Date and time =

submenu.

Move the 5-way button right to open the Date and time
submenu.

Move the 5-way button left or right to
move between the various date (yy/
mm/dd) and time (hh:mm) fields.
Move the 5-way button up or down to
change the various date and time
fields.

Press OK when finished.

Setting the TV out

Use this option to specify the TV out format. See “Setting the out-
put mode” on page 43 for more information.
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Setting the frequency

Use the frequency menu to set the frequency of the camera. This
value should be the same as the frequency of the power supply at
the location where you are using the camera. This prevents lights
flickering when taking pictures or video.

1. Turn on the camera and switch to picture mode.
2. Press Menu.

3. Move the 5-way button left or right to
navigate to the Setup menu. Date and time

TV out

4. Move the 5-way button up or down to
highlight the Frequency submenu.

5. Move the 5-way button right to open
the Frequency submenu.

6. Move the 5-way button up or down to
select 50Hz or 60Hz.

7. Press OK when finished.
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Setting the auto power off function

The auto power off function turns off power automatically after a
specified period in order to conserve power. Use the following pro-
cedure to set the auto power off interval.

1
2.
3.

7.

Turn on the camera and switch to picture mode.
Press Menu. —
Move the 5-way button leftor rightto b

C“‘ a!e and time

navigate to the Setup menu. ~ TVout

Frequency
STe o

Move the 5-way buttonup ordownto [&
highlight the Auto power off %y
submenu.

Move the 5-way button right to open
the Auto power off submenu.

Move the 5-way button up or down to

select from one of the following
0pt|0nS: ~ 2 minutes

- 1 minute o PEETIE
— 2 minutes

— 5 minutes

— Never

Press OK when finished.

Setting the language
To set the menu language, do the following:

1
2.
3.

Turn on the camera and switch to picture mode.
Press Menu. —
Move the 5-way button leftorrightto | F=r Lo o
navigate to the Setup menu. ~ Frequency

Move the 5-way button up or down to
highlight the Language submenu.
Move the 5-way button right to open
the Language submenu.

Auto power off
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6. Move the 5-way button up or down to
select from one of the following A
options: ¢~ Deutsch

— English | —
— German
— French
— Italian
— Spanish
— Dutch
— Czech
— Polish
— Russian
— Traditional Chinese
— Simplified Chinese
— Korean
— Japanese
— Bulgarian
— Portuguese
7. Press OK when finished.
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Restoring defaults

Use the setup menu to restore the camera settings to their default
values as follows:

1. Turnon the camera and switch to picture mode.

2. Press Menu. —

3. Move the 5-way button left or right to C‘E’ ]
navigate to the Setup menu. o~ Auto power off

4. Move the 5-way button up or down to 5
highlight the Default submenu.

5. Move the 5-way button right to open
the Default submenu.

6. Move the 5-way button up or down to
select Confirm to reset the camera or
Cancel to cancel the operation.

7. Press OK when finished.
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Memory Formatting
Format the camera’s memory by the following steps:

1. Turnon the camera and switch to picture mode.
2. Press Menu. __
3. Move the 5-way button left or rightto [ EE

Auto power off

navigate to the Setup menu. o Language

4. Move the 5-way button up or down to
highlight the Format submenu.

5. Move the 5-way button right to open
the Format submenu.

6. Press the 5-way button’s UP or DOWN
buttons to select OK in order to for-
mat the memory, or select Cancel to
cancel the operation.

7. Press OK when finished. The memory
of the camera is formatted. All files,
including protected files, are deleted.

Confirm

Warning: Memory formatting will delete all files stored in the memory. Make
sure you have backed up any files you still want.
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Playing games on the camera screen

- Four games are provided as an additional feature. You can use the
§ buttons and the LCD of the camera to play games. To select a game,
g do the following:
N, 1. Turn on the camera and switch to picture mode.
a 2. Press Menu. —
S 3. Move the 5-way button leftorrightto [ == <
- navigate to the Games menu. ~ Lucky 777
S 4. Move the 5-way button up ordownto [
] highlight one of the following games:
= — Magic beads
— Lucky 777
— Lottery
— Boxman
— Tiling
5. Move the 5-way button right to select the game and start
playing.

6. Press Menu to stop the game at any time.




Chapter 4 Reviewing photos or movie clips

Move the Mode switch to
center to switch to playback
mode.

The LCD screen displays the
most recent image. If the
most recent file is a video

@mw\”\

Mode switch

clip, it displays the first frame of the movie clip on the screen. No
image is displayed if the most recent file is an audio file.

bre] WREEEE | EEPAVI
& e

Image file
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Video file

Audio file
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To browse through your images and video or audio clips, do the
following:

1. Move the 5-way button right or left to skip to the next or
previous file.

2. Ifthefile is a video clip, press the :
Shutter to start playing the video clip. | @« & o
Press OK to stop playback. Playback |
status is displayed on the screen,
along with the playback icon.

3. Ifthe file is an audio clip, press the
Shutter to start playing the audio clip.
Press OK to stop playback. Playback status is displayed on
the screen, along with the playback icon.

4. You can attach a voice memo to an image by pressing the
Voice button. Press the button again to stop recording. To
play a voice memo, please press the Shutter button. To
learn about deleting the voice memo, see “Deleting a voice
memao”on page 34.
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Zooming in

You can use the digital zoom feature to zoom
in and examine the fine details of the picture. e O
Press the Zoom in button to magnify the
image and the Zoom out button to decrease
the zoom ratio. The zoom ratio is indicated by
the zoom window over the thumbnail image
at the lower right corner of the screen.

The magnified image is initially centered on

the LCD. To pan the view and see different Ll
parts of the magnified image, move the 5-way
button left, right, up, or down. The lower right
corner shows the thumbnail image along with
the zoom area highlighted.
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Deleting files

In playback mode, you can easily delete any pictures or audio/video
clips that you are not satisfied with, before transferring them to the
PC. To delete unwanted files, do the following:

1. Inplayback mode, use the 5-way button to browse to the
image or audio/video clip that you want to erase.

2. Move the 5-way button down to dis-
play the Erase menu.

3. Using the 5-way button, select one of
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the following options: Al

— All: erases all files. Currentig)

— Current: erases the currently e
selected file.

— Cancel: cancels the delete operation.

4. Press OK to confirm the operation.
The selected files are deleted.

Protecting files
To lock images or audio/video clips in order to prevent them from
being deleted accidentally, do the following:

1. In playback mode, use the 5-way button to browse to the
image or audio/video clip that you want to protect.

2. Move the 5-way button up to display

the Protect menu.

3. Using the 5-way button, select one of
the following options:

— Current

- All

— Cancel

4. Press OK to confirm the operation.

The selected files are protected.
If the selected file is previously protected, the Unprotect menu is
displayed when you move the 5-way button up. Remove the lock if
required in a manner similar to protecting the image.

All
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Editing images

The playback menu has various options to enable you to edit
pictures by resizing, cropping, or rotating. Refer to the following
sections for more details.

Resizing images
To resize an image, do the following:

1.

Rotating images

In playback mode, use the 5-way button to browse to the
image that you want to resize.

Press Menu.

Move the 5-way button left orright to [t
navigate to the Edit menu. £3 iy —
Move the 5-way button up ordownto [ -~
highlight the Resize submenu. >

m\v(‘us‘tomize
Move the 5-way button right to open ‘
the Resize submenu.

Move the 5-way button up or down to
select from the resize options: VGA,
1.3M, 3.1M, or 5.0M.

Press OK when finished.

To rotate an image, do the following:

1.

In playback mode, use the 5-way button to browse to the
image that you want to rotate.
Press Menu.

Move the 5-way button left or right to g
navigate to the Edit menu. e
Move the 5-way buttonup ordownto i
highlight the Rotate submenu. mm
Move the 5-way button right to open
the Rotate submenu.

Crop




6.

7.
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Move the 5-way button up or down to
select one of the following options:

— Rotate

- Save -
— Cancel | e
Press OK when finished. w -

Cropping files
The cropping feature enables you to cut off unwanted parts of the
picture. To crop an image, do the following:

1.

2.
3.

In playback mode, use the 5-way button to browse to the
image that you want to crop.
Press Menu.

Move the 5-way button left orrightto et
navigate to the Edit menu. €1 2u
Move the 5-way button up or down to
highlight the Crop submenu. m\\ Customize
Move the 5-way button right to open
the Crop submenu.

Move the 5-way button up or down to
select one of the following options:

- 43

- 32

¢ Rotate

Move the 5-way button right to start
cropping.

The cropping window is displayed on
the image. Use the 5-way button to
move the cropping window and
select the area to be cropped.

Press OK when finished.
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Deleting a voice memo

You can use the playback menu to delete a voice memo attached to
an image. To delete a voice memo, do the following:

1.

In playback mode, use the 5-way button to browse to the
desired image with a voice memao.
Press Menu.

Move the 5-way button left or rightto  [gffse |

¢ Rotate

navigate to the Edit menu. L cros
Move the 5-way button up ordownto  [SEERER
highlight the Voice Memo submenu.

Move the 5-way button to open the
Voice memo submenu.

Select Delete to delete the voice
memo attached to the image or select
Cancel to cancel the operation.

Press OK when finished.
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Using the slideshow function
The slideshow feature of the camera enables you to view all the
images automatically on the LCD screen. You can set the slideshow
interval, direction, etc. and customize the slideshow as required.

Note: Audio/video clips are not played back during the slide
show. The first frame of the video clips are displayed

during the slide show.

Refer to the following sections to set up a slide show.

Setting the starting point
To specify the starting point of the slide show, do the following:

1.
2.

Press Menu.

Move the 5-way button left or right to
navigate to the Slide menu.

Move the 5-way button up or down to
highlight the Show submenu.

Move the 5-way button right to open
the Show submenu.

Move the 5-way button up or down to
select one of the following options:

— From current

— From first

— From last

Press OK when finished.
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Setting the slideshow interval

To set the interval between consecutive images during the slide
show, do the following:

1. Press Menu.

2. Move the 5-way button left or right to
navigate to the Slide menu. o

fgtise. |

3. Move the 5-way buttonup ordownto [E& Z:‘ "
highlight the Interval submenu. 2 : - |

4. Move the 5-way button right to open  FSSUEIEL >
the Interval submenu.

5. Move the 5-way button up or down to
select one of the following options for
the interval:

— 1sec
- 3sec
- 5sec
6. Press OK when finished.
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Setting the direction

To specify the order in which the slide show displays the images, do
the following:

1. Press Menu.

2. Move the 5-way button left or right to
navigate to the Slide menu.
3. Move the 5-way buttonup ordownto SRS
highlight the Direction submenu. E oa
4. Move the 5-way button right to open
the Direction submenu.
5. Move the 5-way button up or down to
select one of the following options:
— Backward
— Forward

6. Press OK when finished.
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Repeating the slideshow
To loop the slideshow repeatedly, do the following:
1. Press Menu.

2. Move the 5-way button left or right to
navigate to the Slide menu.

3. Move the 5-way buttonup ordownto il

¢ Interval

highlight the Repeat submenu. DifectilR

r

4. Move the 5-way button right to open
the Repeat submenu.

5. Move the 5-way button up or down to
select Yes to repeat the slideshow or
No to display the slide show only
once.

6. Press OK when finished.
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Starting the slideshow

After setting up the slide show, you are now ready to start the slide
show. To start the slide show, do the following:

1. Press Menu.
2. Move the 5-way button left or right to

navigate to the Slide menu. o
3. Move the 5-way button up or down to s
open the Play submenu. ¥ eieral

4. Press OK. The slide show starts. Press o Direction
the OK button at any time to stop the
slide show.
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Ordering prints

You can set up printing information for printing the digital images
taken with your digital camera. Refer to the following sections for
more information:

Using DPOF

The DPOF (Digital Print Order Format) refers to a format that is used
for recording the print specifications of images. Use the following
procedure to set the DPOF information for a selected image.
1. In playback mode, use the 5-way button to browse to the
desired image.
2. Press Menu.

3. Move the 5-way button left orrightto & Jernt |

navigate to the Print menu. J e
4. Move the 5-way buttonup ordownto [

highlight the DPOF submenu. o
5. Move the 5-way button right to open

the DPOF submenu.

6. Use the 5-way button to select Cur-
rent to set the DPOF information for
the current image or Reset to clear
the DPOF information for the image.

7. Press OK.

The DPOF information is stored with the
image as indicated by the DPOF icon. This
information enables you to take prints for the
image from a DPOF-compatible printer.
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Using Direct-Print

You can also connect a printer to the digital camera using the USB
port and take prints directly. To set the number of prints for an
image, do the following:

1.

2.
3.

In playback mode, use the 5-way button to browse to the
desired image.

Press Menu.

Move the 5-way button left or right to
navigate to the Print menu.

Move the 5-way button up or down to
highlight the Direct-Print submenu.
Move the 5-way button right to open
the Direct-Print submenu.

Use the 5-way button to select
Current to print the current image or
Cancel to cancel the operation.

Press OK.

Use the 5-way button to select the
Copies option and set the number of
copies to be printed by moving the
button left or right.

Select the Print option and press OK <01 copicSID
to start printing. St
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This chapter describes how to connect the digital cameratoa TV
for reviewing your pictures and videos, or to a PC to transfer your
files.

Connecting to a PC

You can connect your camera to a PC via the USB port and transfer
photos to the PC. You can also use the camera as a web camera and
use it for video conferencing. Refer to the following sections for
more information.

Installing the software

The software CD provided with the digital camera contains the soft-
ware driver required to use the camera as a web camera and to
transfer data from it. It also contains various software applications
to help you view and edit your digital photos and videos. To install
the software, do the following:

1. Insert the CD into your PC’s CD drive. The CD menu
is displayed.
2. Select one of the following options:
— Digital Camera Driver
— Ulead Photo Explorer 8.0SE
— Ulead Video Studio 7.0SE
— Ulead Cool 360
— Acrobat Reader
— User Manual

3. Click Install to start the installation. Follow the
instructions on the screen to complete the installa-
tion.
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Changing the USB setting

You can use the camera as a storage device and transfer the photos
to the PC. You can also use it as a web camera for video conferenc-
ing. To configure the USB setting, do the following:

1. In picture mode, press Menu to dis-
play the menu. o Setmal |

2. Move the 5-way button left or right to Bl
navigate to the Setup menu.

3. Move the 5-way button up or down to
highlight the USB submenu.

4. Move the 5-way button right to open

Date and time
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the USB submenu.
5. Move the 5-way button up or down to
select one of the following options: it
— Storage  PC camera
— PC camera 'k

(<

6. Press OK when finished.

Connecting the USB cable
To connect the camera to the PC, do the following:

1. Turn on the camera.

2. Connect the digital
camera to the com-
puter with the USB
cable.

3. The LCD displays
Memory or Camera and
Close. All camera but-
tons are disabled.
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Connectingtoa TV

You can connect the digital camerato a TV and use the TV screen to
review your images and play back your video clips.

Setting the output mode

Before connecting the camera to a TV, you need to set the TV out-
put mode and make sure it matches that of your TV. to set the TV
output mode, do the following:

1.

2.
3.

In picture mode, press Menu to dis-
play the menu.

Move the 5-way button left or right to
navigate to the Setup menu.

Move the 5-way button up or down to
highlight the TV out submenu.

Move the 5-way button right to open
the TV out submenu.

Move the 5-way button up or down to
select the NTSC or PAL option.

Press OK when finished.
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Viewing images on the TV
To view images and videos on the TV, do the following:

1. Turn the camera on
and set it to playback
mode using the mode
switch.

2. Connectthe TV out
jack on your digital
camera to the audio /
video input ports on
your TV using the AV
cable provided. The
LCD screen turns off.

3. Use the procedures
described in “Review-

ing photos or movie clips” on page 29 to play back the files
on your camera.
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Appendix

Specifications
Image sensor 1/1.8-inch CMOS
Resolution 3 megapixels (2074 x 1540 pixels)
Extrapolated 12 megapixels
resolution

Shutter speed 1/6 ~ 1/4000 second

Zoom 8x digital zoom

LCD 25Inch TFT

Internal memory | 32 MB SDRAM

Supported Secure Digital card
media

Image JPEG/EXIF 2.1/DPOF
Video AVI (CIF)

Audio WAV

Connections USB 2.0

Power 2 x AAA batteries

Weight 859
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Error Messages

Error Message

Card Full

Possible causes

The card is full, and no
more files can be stored
on the card.

Solutions

Delete some files or insert
another card.

Write-Protect

Card has been write
protected.

Move the card’s write protect
switch to turn off write
protection

Card Error

¢ The card maybe
damaged.

* The card may require
formatting.

» Format the card
+ Insert another card.

Picture Error

The picture cannot be
viewed with the camera

View the image on a computer.
If the picture cannot be viewed,
the file may be damaged.

sufficient charge for
camera to operate.

No picture There are no files on the |+ Take pictures or video.
memory or card. + Insert another card.
Card Setup The card is not format- | Format the card.
ted
Battery Empty Battery does not have + Replace batteries.

+ Recharge batteries.
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	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Setting the slideshow interval
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Interval submenu.
	4. Move the 5-way button right to open the Interval submenu.
	5. Move the 5-way button up or down to select one of the following options for the interval:
	6. Press OK when finished.

	Setting the direction
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Direction submenu.
	4. Move the 5-way button right to open the Direction submenu.
	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Repeating the slideshow
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to highlight the Repeat submenu.
	4. Move the 5-way button right to open the Repeat submenu.
	5. Move the 5-way button up or down to select Yes to repeat the slideshow or No to display the sl...
	6. Press OK when finished.

	Starting the slideshow
	1. Press Menu.
	2. Move the 5-way button left or right to navigate to the Slide menu.
	3. Move the 5-way button up or down to open the Play submenu.
	4. Press OK. The slide show starts. Press the OK button at any time to stop the slide show.


	Ordering prints
	Using DPOF
	1. In playback mode, use the 5-way button to browse to the desired image.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Print menu.
	4. Move the 5-way button up or down to highlight the DPOF submenu.
	5. Move the 5-way button right to open the DPOF submenu.
	6. Use the 5-way button to select Current to set the DPOF information for the current image or Re...
	7. Press OK.

	Using Direct-Print
	1. In playback mode, use the 5-way button to browse to the desired image.
	2. Press Menu.
	3. Move the 5-way button left or right to navigate to the Print menu.
	4. Move the 5-way button up or down to highlight the Direct-Print submenu.
	5. Move the 5-way button right to open the Direct-Print submenu.
	6. Use the 5-way button to select Cu�rrent to print the current image or Cancel to cancel the ope...
	7. Press OK.
	8. Use the 5-way button to select the Copies option and set the number of copies to be printed by...
	9. Select the Print option and press OK to start printing.



	Connecting to a PC or TV
	Connecting to a PC
	Installing the software
	1. Insert the CD into your PC’s CD drive. The CD menu is displayed.
	2. Select one of the following options:
	3. Click Install to start the installation. Follow the instructions on the screen to complete the...

	Changing the USB setting
	1. In picture mode, press Menu to display the menu.
	2. Move the 5-way button left or right to navigate to the Setup menu.
	3. Move the 5-way button up or down to highlight the USB submenu.
	4. Move the 5-way button right to open the USB submenu.
	5. Move the 5-way button up or down to select one of the following options:
	6. Press OK when finished.

	Connecting the USB cable
	1. Turn on the camera.
	2. Connect the digital camera to the computer with the USB cable.
	3. The LCD displays Memory or Camera and Close. All camera buttons are disabled.


	Connecting to a TV
	Setting the output mode
	1. In picture mode, press Menu to display the menu.
	2. Move the 5-way button left or right to navigate to the Setup menu.
	3. Move the 5-way button up or down to highlight the TV out submenu.
	4. Move the 5-way button right to open the TV out submenu.
	5. Move the 5-way button up or down to select the NTSC or PAL option.
	6. Press OK when finished.

	Viewing images on the TV
	1. Turn the camera on and set it to playback mode using the mode switch.
	2. Connect the TV out jack on your digital camera to the audio / video input ports on your TV usi...
	3. Use the procedures described in “Reviewing photos or movie clips” on page�29 to play back the ...
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